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INSTRUCTIONS CONTAINED IN THIS QUICK START GUIDE
This Quick Start Guide contains software and hardware installation instructions along with information
for hardware setup for serial and Ethernet data capture. The NetDecoder software captures:
•

Serial data via the RS‐232 ComProbe II and the RS‐422/485 ComProbe.

•

Ethernet data through the analysis PC’s NIC card or Frontline’s Ethernet ComProbe network tap.

•

CC‐Link data via the CC‐Link ComProbe

The NetDecoder analyzer also supports other industrial buses including ControlNet, DeviceNet and Data
Highway Plus. If your bus is any one of these, then please refer to their respective Setup Guide. All
documentation is found in the ‘Desktop Æ Frontline NetDecoder [version] Æ Documentation’ folder.
The software for all modes of data capture is identical in many respects so there is just one set of
instructions on how to use the NetDecoder software.
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MINIMUM SYSTEM REQUIREMENTS
•
•
•
•
•

PC with Windows XP (Service Pack 2 or higher, 32‐bit only), or Windows 7 (32‐bit or 64‐bit)
Intel Core 2 Duo 2.2 GHz Processor or Higher
RAM Requirements: 1GB minimum, 2GB recommended
50 MB free Hard Disk Space
One USB 2.0 Port
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INTRODUCTION
Welcome to Frontline’s NetDecoder™ software protocol analyzer. The design of NetDecoder allows you
to conduct data analysis of protocols using your personal computer. The user interface is easy to use
without training, but we recommend you watch the videos available on the NetDecoder CD or on
Frontline’s web site at www.fte.com. You should also read the online Help to take maximum advantage
of all the features.
We designed the online Help System with complete explanations and easy to use systematic
instructions. Access the online Help by choosing Help Topics from the Help menu, or by pressing the F1
key on any window.
To access the PDF version of this Quick Start Guide from your Windows operating system, click Start |
Programs | NetDecoder [version#] | Quick Start Guide

INSTALLATION INSTRUCTIONS
Software Installation
You must have an RS‐232 ComProbe, RS‐422/485 ComProbe or CC‐Link ComProbe to install the
NetDecoder software.
1. Install one the ComProbes following the instructions below.
2. Keep the ComProbe plugged in to the PC and run the installer.
3. You will see the following options:

Figure 1 ‐ NetDecoder installer options

4. Select ‘Live Product’ and follow the installation wizard to complete your NetDecoder software
installation.

Installing the Serial ComProbes
These instructions apply to Frontline’s RS‐232 ComProbe II, RS‐422/485 ComProbe and the CC‐Link
ComProbe. For your convenience, Frontline has made the Drivers required for installing these
ComProbes available at multiple locations. You can find them on any one of these locations:
1. On the NetDecoder CD you received from Frontline
2. On the Frontline website at: http://www.fte.com/support/drivers.aspx.
3. At ‘C:\Program Files\Frontline Test System II\Frontline NetDecoder [version]\Drivers\Serial
ComProbes’, if you already have a version of the NetDecoder software installed on your PC.
When first connecting the ComProbe to your PC you will be directed to install the required Frontline
interface driver.
1. Connect the USB cable into the back of the RS‐232 ComProbe II. The RS‐422/485 ComProbe and
the CC‐Link ComProbe have a built in USB cable.
2. Connect the ComProbe to a USB port on the computer.

Page |2

The Found New Hardware Wizard dialogue box appears which may ask you if you want to connect to
Windows Update to search for software.

Figure 2 ‐ Install Wizard Welcome

3. Choose No, not this time and click Next.

Figure 3 ‐ Found New Hardware Wizard Dialog

4. Choose Install from a list or specific location and click Next.
Now you have to locate the RS‐232 ComProbe II driver.
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Figure 4 ‐ Browse

5. Click the Browse button.

Figure 5 ‐ Directory Structure

6. Locate the directory where you installed NetDecoder (the default is C:\Program Files\Frontline
Test System II\Frontline NetDecoder [version #]\Drivers\Serial ComProbes). If you have the
drivers on the CD or if you have downloaded them to a different location on your PC, point the
wizard to that location.
7. Select the appropriate directory and click OK.
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Figure 6 ‐ Select File Location Dialog

8. Click the Next button to finish the installation.
9. If you get a dialog box like the one below, don’t worry—click Continue Anyway.

Figure 7 ‐ Hardware Installation

Your computer will now install the ComProbe driver from the directory you selected; you’ll get a dialog
box saying that the installation is finished.
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Figure 8 ‐ Installation Complete

10. Click the Finish button to close the wizard.
Your computer will remember this USB application. The next time you insert the RS‐232 ComProbe II (or
other ComProbe), your PC will automatically find the appropriate interface driver.

Ethernet ComProbe Driver Installation
When first connecting the Ethernet ComProbe to your PC, you will be directed to install the required
Frontline interface driver.
1. Connect the Ethernet ComProbe to a USB port on the computer with NetDecoder installed.
The Found New Hardware Wizard dialogue box appears which may ask you if you want to connect to
Windows Update to search for software.

Figure 9 ‐ Install Wizard Welcome
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2. Choose No, not this time and click Next.

Figure 10 ‐ Found New Hardware Wizard Dialog

3. Choose Install from a list or specific location and click Next.
Now you have to locate the Ethernet ComProbe driver.

Figure 11 ‐ Browse

4. Make sure the Include this location in the search checkbox is selected, then click the Browse
button.
5. Locate the directory where you installed NetDecoder (the default is C:\Program Files\Frontline
Test System II\Frontline NetDecoder [version #]\Drivers\Ethernet ComProbe)
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Figure 12 ‐ Directory Structure

6. Select the directory among Vista 32bit, Vista 64bit, WinXP 32bit, or WinXP64bit and click OK.

7. Click the Next button to finish the installation.

Figure 13 ‐ Select File Location Dialog

8. If you get a dialog box like the one below, don’t worry—click Continue Anyway.
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Figure 14 ‐ Hardware Installation

Your computer will now install the Ethernet ComProbe driver from the directory you selected.

Figure 15 ‐ Installation Continuing

You’ll get a dialog box saying that the installation is finished.
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Figure 16 ‐ Installation Complete

9. Click the Finish button to close the wizard.
10. Since the Ethernet ComProbe installs as a NIC card on your PC with a new MAC address, we
recommend that you restart the PC for the ComProbe to work correctly.
The installation of the NetDecoder software and the Ethernet ComProbe driver are now complete.

Configure Ethernet Comprobe
After you install WinPcap, you have to configure the IP address and Subnet Mask for the Ethernet
ComProbe.
1. Select Network Connections from the Control Panel.

Figure 17 ‐ Network Connections

2. Right click on the LAC for the Ethernet ComProbe and select Properties.
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Figure 18 ‐ LAC Properties

The LAC Properties dialog appears.

Figure 19 ‐ Properties Dialog

3. Scroll down and select Internet Protocol (TCP/IP).
4. Select Properties.

Figure 20 ‐ Select Properties

The Properties dialog appears.
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Figure 21 ‐ Properties Dialog

5. Select the Use the following IP address radio button.

6. Enter 192.168.0.1 for the IP address.
7. Enter 255.0.0.0 in the Subnet mask.
8. Select OK to close the Properties dialog.
9. Select OK again to close the LAC Properties dialog and complete the process.

Windows 7 Installation
The procedure for installing the ComProbe driver is different for Windows 7 than it is for XP. Follow the
steps below.
1. Plug the ComProbe into a USB port. The Found New Hardware Wizard dialogue box appears,
then disappears.

Then a message similar to this one appears/disappears indicating that the driver software has not been
installed.
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When the dialog disappears,
2. Go to the Control Panel and open the Device Manager.

Figure 22 ‐ Device Manager

3. Right click on RS‐232 ComProbe II under Other Devices and select Update Driver Software.
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Figure 23 ‐ Update Driver Software

The next step is to choose the driver location.
4. Select Browse my computer for driver software.

Figure 24 ‐ Browse my computer for driver software

5. On the next dialog, select the Browse button.

P a g e | 14

Figure 25 ‐ Update Driver Software

Now you have to drill down to find the folder that contains the driver. The driver is located at:
C:\Program Files[X86]\Frontline Test System II\Frontline [Application Name and #]\Drivers\Serial
ComProbes

Figure 26 ‐ Browse for Folder

6. Select the Serial ComProbes folder.
7. Select OK

The Browse for driver software on your computer dialog reappears.
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Figure 27 ‐ Browse for driver software on your computer

8. Select Next.
Once the driver starts to load,

Figure 28 ‐ Software Loading – Windows 7

you may get a Windows Security warning.

P a g e | 16

Figure 29 ‐ Windows Security Warning

9. You can ignore this warning by selecting Install this driver software anyway.

Your computer will now install the ComProbe driver from the directory you selected; you will get a
dialog box saying that the installation is finished.

Figure 30 ‐ Installation Complete

10. Click the Close button to close the wizard.
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When you close this dialog you will see that the correct driver is displayed in the Device Manager under
Frontline Test Equipment ComProbes.

Figure 31 ‐ Device Manager
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Initial Startup and Hardware Installation
The software installation creates a folder on your desktop.
1. Open the desktop folder and double‐click the shortcut labeled Frontline NetDecoder.
2. NetDecoder displays the Choose Protocol to Analyze dialog that contains a list of the available
protocols.
3. Select the desired protocol
4. Select a capture method from the Data Capture Method selection pane below the list window (if
necessary).
5. Check the Create Shortcut When Run checkbox if you like and click the Run button (if you choose
to create a shortcut, the system creates one and places it in the desktop folder).
Alternatively, you can access the Choose Protocol to Analyze dialog from your Windows operating
system by clicking Start | Programs |NetDecoder [version#] |Frontline NetDecoder. Then select the
protocol from the displayed list. Consult the online Help for additional information on choosing
protocols.
The first time you run the program, the Hardware Settings window appears. You can find instructions for
the different types of Hardware Settings windows: Ethernet and serial, in the following sections.
You can change any of the hardware settings, at anytime, by choosing Options | Hardware Settings from
the Control window.

Ethernet Hardware Setup
The NetDecoder software will work with any Ethernet card with an NDIS driver. Some cards do not pass
all frames through the card, so the amount of data captured may not represent all the data on the
Ethernet segment.
Please refer to the card documentation for instructions on installing your Ethernet card.
1. Open the Hardware Settings window. This window comes up automatically the first time you
run NetDecoder, or you can choose Hardware Settings from the Options menu on the Control
window to access it at any time.
2. In the "Use this Network Adapter" list, select which Ethernet card to use.
3. Click OK.
Some protocols have additional setup requirements. Please read the online Help for information or refer
to the protocol specific Setup Guides found in the desktop folder in the Documentation sub‐folder.
That's all you need to do. You are now ready to begin capturing data. Skip to the section on "Using
NetDecoder ‐ The Tour".
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Asynchronous Serial Hardware Setup
RS‐232 ComProbe II Setup
The NetDecoder analyzer captures asynchronous RS‐232 data using the RS‐232 ComProbe II. This
ComProbe is Thumb Drive sized device that plugs in to the PC’s USB port.
Frontline's ComProbes are passive devices. Some serial analyzers receive data from one side of the
circuit under test and retransmit it to the other side. The RS‐232 ComProbe II does not work that way.
The ComProbe is a passive observer of the communications between the Devices‐under‐Test.
To assist customers in tapping into Async RS‐232 bus configurations, Frontline provide customers with a
lot of flexibility to address different monitoring situations. The RS‐232 ComProbe II can be used directly
in‐line, or connected via a combination of a provided Y‐cable and/or the 6 foot RS‐232 extension cable.
Some monitoring situations may require a pair of 25‐pin to 9‐pin adapters. All the required accessories
are included in the product.
The monitoring connection options are displayed below.
Monitoring Connection Option 1 – RS‐232 ComProbe II Only

Figure 32 – RS‐232 ComProbe II Only

Monitoring Connection Option 2 – RS‐232 ComProbe II with Y‐Cable

Figure 33 – RS‐232 ComProbe II with Y‐Cable

Monitoring Connection Option 3 – RS‐232 ComProbe II with Y‐Cable and Extension
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Figure 34 – RS‐232 ComProbe II with Y‐Cable and Extension
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USING NETDECODER ‐ THE TOUR
The first window that opens up when you launch the software is the Control window. The Control
window is the small rectangular window at the top, and the NetDecoder software is organized around
this window. From the Control window, you control data capture and have access to the other windows
used to view data.

How to Capture Data
The NetDecoder software can capture data to a single file or a series of files. Data capture can be
initiated from the Control window, the Event Display or Frame Display, though you do not need any
window other than the Control window open to capture data.
•

To capture to a file, click the Start Capture icon

•

To stop capture to disk, click the Stop icon
. Stopping capture means no new data will be
added to the capture file until capture is resumed by clicking the Start Capture icon.

•

To clear capture, click the Clear icon

.

.

If you select Clear after selecting Stop, a dialog appears asking whether you want to save
the data.
•

You can click Save File and enter a file name when prompted .

•

If you choose Do Not Save, all data will be cleared.

•

If you choose Cancel, the dialog closes with no changes.

If you select the Clear icon while a capture is occurring:
•

The capture stops.

•

A dialog appears asking if you want to save the capture

•

You can select Yes and save the capture or select No and close the dialog. In
either case, the existing capture file is cleared and a new capture file is started.

•

If you choose Cancel, the dialog closes with no changes.

If the file becomes full, data capture will begin to wrap, which means the oldest data will be overwritten
by new data. You can tell how full the file is by checking the bar graphic next to Capture Status on the
status bar of the Control window. If you do not want the file to wrap, choose System Settings from the
Options menu on the Control window and uncheck the "Wrap File" box.
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Looking At Data Bytes
Event Display
Click the Event Display icon
on the Control window toolbar to open the Event Display. The Event
Display window is the main view of byte‐level data.
How Data Is Displayed

Data is displayed in hex on the left and ASCII on the right. You can restrict the display to only show Hex
or ASCII using the buttons at the top of the window. The Event Display can also display data in decimal,
binary, EBCDIC, and other character and number formats. Choose the format you would like from the
Data menu, or right‐click on the Hex/ASCII labels in the headers and select a different format.
Click on a byte in the display. The three status lines at the bottom of the window will update to show a
variety of information about the byte, including its value in different radixes and any errors associated
with the byte. Use the mouse to select several bytes. The status lines change to show the data rate
over the range of the selection, the delta time between the first and the last bytes in the selection, and
the CRC. To change the algorithm used to calculate the CRC, click the CRC icon

.

Bytes with errors are shown in red. Click on the byte to see what the error is.
The NetDecoder software displays data other than bytes in the Event Display. Control signal changes
are indicated with an up‐and‐down arrow. Flags are used as start‐of‐frame and end‐of‐frame markers.
These special symbols in conjunction with the data bytes are called events.
Scrolling versus Static View

By default, the Event Display scrolls as data is captured so that it always shows the latest data. To
prevent the Event Display from scrolling, click the Lock icon
scrolling.

. Click the Lock icon again to resume

Looking At Frames
Frame Display
Click the Frame Display icon
on the Control window toolbar to open the Frame Display. This display
allows you to have bit level visibility on your protocol.
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Panes
The Frame Display is divided into panes, where each pane shows a different view of the data. The
Summary pane stretches across the top of the display. Each line in the Summary Pane represents one
frame/message. The Decode pane contains a detailed decode of the frame selected in the Summary
pane, and is located on the left side of the Frame Display window. The three smaller panes on the
bottom right of the Frame Display show the logical data in hex, binary and ASCII. Select any field in the
Decode pane and the corresponding bit(s) or byte(s) will be selected in the logical data panes.
Frame Errors

A frame number in red indicates an error in the frame. Select the frame, and look at the top of the
Decode pane to determine the type of error.
Scrolling versus Static View

Click the Lock icon
to have the Summary pane scroll to always show the latest frames captured.
Click the Lock icon again to stop the Summary pane from scrolling.
Protocol Tabs

The frame display has a series of Protocol Tabs that allow you to filter on a specific protocol quickly and
easily. For more advanced filtering option please consult the online Help.

Common Features
Display Synchronization
The system synchronizes the display in the Frame Display with the Event Display. Select a frame in the
Frame Display and the other windows automatically update to highlight the bytes in the selected frame.
Select a byte in the Event Display and the Frame Display updates to show the frame containing the byte.

Duplicate Displays
The Duplicate icon
creates a second window of the same type, identical to the first. The advantage of
additional Displays is that you can look at two different groups of data at the same time. For example,
you can look at the start of an interaction in one Frame Display and the end of that same interaction in
the other and compare the two.

Filtering
Filtering can be accomplished from the Frame Display. Regardless of where the filter is applied, it affects
the data in both. In the Frame Display, the system creates a tab that displays the filter name.
The quickest and easiest method for filtering data is to hover your cursor over the desired information in
the summary display or the decode pane on the Frame Display and select from the right click popup
menu.
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Bookmarks
Bookmarks let you mark frames of interest so they can be easily found later. Bookmarked frames
appear with a magenta triangle icon next to them except in the Event Display where they appear as a
dashed line around the start of frame marker. You can navigate between bookmarks using the Find
feature or by pressing F2 to go to the next bookmark. To make a new bookmark, right‐click on the
frame and choose Add Bookmark from the menu.

Searching
You can search for strings or patterns in your data or in the frame decode, for errors, control signal
changes, bookmarks, special events, and time. Click the Find
icon to open the Find window. Click the
Help button for more information on the different types of searches.

Statistics
Click the Statistics icon

on the Control window toolbar to open the Statistics window.

The Statistics window provides a statistical overview of all the data on the circuit.
There are three tabs on the Statistics window: Session, Resettable and Capture File. The Session tab
shows statistics from the time the NetDecoder analyzer was started. The Resettable tab can be reset to
show statistics from the time the Reset icon was last pressed. The Capture File tab shows statistics on
the data in the capture file. If data capture has not been started or if the file has wrapped, most of the
statistics on the Capture File tab will be n/a.
Some tables on the Statistics window can display data in graphic form. Click the Graph icon
header that has one for a chart of that table.

on any

Network View
Click the Network icon
on the Control window toolbar for Ethernet related protocol decoders in
the NetDecoder analyzer to open the Network window.

The NetDecoder software’s Ethernet Network View enables you to see statistics on specific nodes
including communications traffic details and node information for active nodes on the monitored side of
the switch. Selectable views enable you to see Packets Transmitted and Received, Bytes Transmitted
and Received, IP Addresses, MAC Addresses and more. When the cursor is placed on a particular node,
a window opens up with additional node information. User friendly names can also be assigned to each
node.
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Node Statistics
The NetDecoder software’s Ethernet Network View enables you to see statistics on specific nodes
including communications traffic details and node information for active nodes on the monitored side of
the switch.
Individual Active Node Information
•

Packets Transmitted and Received

•

Bytes Transmitted and Received

•

DNS Names

•

Nodes In and Out

•

Utilization Information

•

Broadcast Information

•

IP Address and MAC Address

•

Named MAC Address

•

NetBios Name

•

Assigned User Friendly Names for each Node

Dashboard View
The NetDecoder software’s Dashboard View enables you to see the dynamics of what is occurring on
your Ethernet communications network.
An overview of the top talkers, protocol statistics, network utilization along with network alarms for the
section of the network you are monitoring are displayed. NetDecoder is a passive monitor and does not
contribute to network loading.
Dashboard Activity View Features
•
•
•
•
•
•
•
•
•
•
•
•

Network Utilization Meter with Background Color Alert
10 Minute and 60 Minute Histogram of Network Utilization
Graph Specific Activity can be Tied Back to Packet Decode Details
Network Meter for Bad Packets with Background Color Alert
Top Talker Meter with Background Color Alert
Top Ten IP/MAC Addresses Contributing to Network Traffic
10 Minute Histogram of Top Five IP/MAC Address Activity
Distribution of TCP or UDP Application Related COM Protocols
Network Alarms for Unauthorized IP Addresses and User Defined Protocol Alarm Levels
Email Notification Option for Alarms
Display Options for 10MB, 100MB, and 1GB Network Speed
Protocols: Ethernet, Ethernet/IP, ModBus/TCP, DNP3/Ethernet, CC‐Link over Ethernet, and
PROFINET
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Monitoring Control Signals
(DeviceNet and Serial Analysis Only)
The Breakout Box monitors control signals in real‐time. The Signal Display is an overview of all signal
changes in the capture buffer.
Breakout Box

Click the Breakout Box icon

on the Control window toolbar to open the Breakout Box window.

The Breakout Box monitors the six main control signals on an RS‐232 circuit. It displays a count of how
many times each signal has changed since the Breakout Box was opened, and shows the state of the
signal using green and red symbols and line charts.
Signal Display

Click the Signal Display icon

on the Control window toolbar to open the Signal Display.

The Signal Display shows the state of the control signals in the capture file over time. With the Snap To
feature on, click on any control signal line and the control will jump to the nearest signal change.
The Signal Display is synchronized with the Event Display. Click on any signal change in the Signal
Display and the corresponding event will be automatically selected in the Event Display.
Click the Find icon

to search for signal changes. If you are capturing data, you can update the Signal

Display by clicking the New Snapshot icon

.

EXITING NETDECODER
To exit NetDecoder, go to the File menu on the Control window, and choose Exit NetDecoder, or close
the Control window using the X icon in the top right corner of the title bar.
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TECHNICAL SUPPORT
Technical support is available in several ways. The online help system provides answers to many user
related questions. Frontline’s website has documentation on common problems, as well as software
upgrades and utilities to use with our products.
Web:

http://www.fte.com, click Support

Email: tech_support@fte.com
If you need to talk to a technical support representative, support is available between 9am and 5pm,
U.S. Eastern time, Monday through Friday. Technical support is not available on U.S. national holidays.
Phone: +1 (434) 984‐4500
Fax:

+1 (434) 984‐4505
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